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ABSTRACT 

The main goal is to identify suitable to their Anti-hypertensive activity with reference (Clonidine 

Standard drug). Pubchem webserver, Chemsketch, Padel descriptor, Protein data bank (PDB), 

Autodocktools, E-dragon webserver. To generate the Scaffold molecule. To calculate different 

parameters of test sample with its biological activity. To fit the final series of compound with 

particular target. To predict ADMET of final series of compound. After substitution R1 & R2 of 

test sample we have found that the value of different descriptors of QSARs is nearby equal to 

standard drug of clonidine. All the descriptors are (QSARs parameters) of Scaffold molecule H1 

was satisfactorily explained (R
2 

= Approximately 0.99) with the graphical plot of Hansch analysis. 

This compound had very poor blood brain barrier crossing label, good absorption, no 

hepatotoxicity, no mutagenecity. Beside this compound was non-carconogenic after in-silico 

predictions of ADMET.   

Keywords: Hypertension, Treatment, QSARs Study, Material & Methodology, Result & 

Discussion, ADMET Predictions. 
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INTRODUCTION 

Hypertension is a global healthcare problem in both the developed and the developing countries.  

The world prevalence of hypertension was put at 26.4%%. Variable prevalence rates have been 

observed in different parts of the world, with Poland 68.9%, China 9.1%% and USA 29.1%. In 

Sub-Saharan African countries, the prevalence is not completely known. Kenya reported 22.8%, 

Cameroon 16.4 – 29.4% and Ghana 19.3 – 54.6%.  However, a recent study reported a prevalence 

of 36.6% in urban areas and 26.4% in rural areas in Nigeria. Different Nigerian studies have shown 

that the prevalence rates of hypertension in Nigeria range from 26.4% to 36.6%.It have been 

demonstrated that many individuals who have hypertension were unaware of their condition. A 

study in Enugu, Nigeria, showed unawareness prevalence of 70.6% among those who have 

hypertension. Hypertension is a cardiovascular risk problem and has been associated with high 

morbidity and mortality. It puts a lot of stress on the economy of both the developed and the 

developing countries. Around the world, the incidence of hypertension has been projected to be 

rising. Some associated factors of hypertension have been identified. They include age, 

consumption of red meat, body mass index (BMI), and the number of children in the family. If 

uncontrolled, hypertension may lead to cardiovascular end-points which include blindness, renal 

damage, heart failure, stroke, dementing illnesses, ischemic heart disease among others 
(1)

.  

 

Figure 1: World prevalence of hypertension 
(2)

 

India, the world’s largest democracy, is undergoing a rapideconomic growth. This growth has been 

accompanied bydemographic, lifestyle and cultural changes which have system. Whilst such 

changes may be most obvious in major cities, such as Delhi and Mumbai, they are also likely to 
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impact those living in the rural areas. Over 70% of India’s population live in rural areas, yet access 

to government healthcare is much poorer than in urban areas, with twice the number of hospital 

beds available to urban dwellers per head of population. In India, cardiovascular diseases (CVDs) 

are estimated to be responsible for 1.5 million deaths annually. Indeed, it is estimated that by 2020, 

CVDs will be the largest cause of mortality and morbidity in India.  Hypertension is a major risk 

factor for CVDs, including stroke and myocardial infarction, and its burden is increasing 

disproportionately in developing countries as they undergo demographic transition. Using a cut-off 

of 140 mmHg or greater systolic blood pressure (BP), or 90 mmHg or greater diastolic BP, the 

age-standardized prevalence of hypertension worldwide in the year 2000 was estimated to be  

26.6% in men (95% Confidence interval, CI 26.0 to 27.2)  and 26.1 % women  (95% CI 25.5 to 

26.6). This was estimated to rise to 29.0% in men (95% CI 28.6 to 29.4) and 29.5% in women 

(95% CI 29.1 to 29.9) by 2025.  It was estimated that around two-thirds of those with people with 

hypertension worldwide were living in developing countries (639 million) in 2000, and that this 

would rise to three-quarters living in developing countries (1.15 billion) by 2025 
(2)

. 

 

Figure 2: Lifestyle factors among diagnosed patients of Hypertension
 (3)
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Figure 3: Knowledge of patients about symptoms of Hypertension 
(3) 

PATHOPHYSIOLOGY OF HYPERTENSION: 

 

Figure 4: Pathophysiology of Hypertension 
(4)

 

TREATMENT OF HYPERTENSION: 

Classification of anti-hypertensive drugs  : 

Diuretics: 

Thiazides:Hydrochlorothiazide, chlorthalidone 

High ceiling: Furosemide 

K+ sparing: Spironolactone, triamterene and amiloride 

MOA: Acts on Kidneys to increase excretion of Na and H2O - decrease in blood volume decreased 

BP 

Angiotensin-converting Enzyme (ACE) inhibitors: 

Captopril, lisinopril., enalapril, ramipril and fosinopril MOA: Inhibit synthesis of Angiotensin II – 

decrease in peripheral resistanc and blood volume 

Angiotensin (AT1) blockers: 
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Losartan, candesartan, valsartan and telmisartan 

MOA: Blocks binding of Angiotensin II to its receptors 

Centrally acting: Clonidine, methyldopa 

MOA: Act on central α2 Areceptors to decrease sympathetic outflow – fall in BP 

ß-adrenergic blockers: 

Non-selective: 

Propranolol (others: nadolol, timolol, pindolol, labetolol) 

Cardioselective: Metoprolol 

(Others: atenolol, esmolol, betaxolol) 

MOA: Bind to beta adrenergic receptors and blocks the activity 

ß and α - adrenergic blockers: 

Labetolol and carvedilol 

α adrenergic blockers: Prazosin, terazosin, doxazosin, phenoxybenzamine and phentolamine 

MOA: Blocking of alpha adrenergic receptors in smooth muscles -Vasodilatation 

Calcium Channel Blockers (CCB): 

Verapamil, diltiazem, nifedipine, felodipine, amlodipine, nimodipine etc. 

MOA: Blocks influx of Ca++ in smooth muscle cells – relaxation of 

SMCs – decrease BP 

K+ Channel activators: 

Diazoxide, minoxidil, pinacidil and nicorandil 

MOA: Leaking of K+ due to opening – hyper polarization of SMCs  relaxation of SMCs 

Vasodilators: 

Arteriolar – Hydralazine (also CCBs and K+ channel activators) 

Arterio-venular: Sodium Nitroprusside 
(3) 

QSARs STUDY: 

The Quantitative Structure-Activity Relationships (QSARs) paradigm is based on the assumption 

that there is an underlying relationship between the molecular structure and biological activity. On 

this assumption QSARs attempts to establish a correlation between various molecular properties of 

a set of molecules with their experimentally known biological activity.  There are two main 

objectives for the development of QSARs:  

1) Development of predictive and robust QSARs, with a specified chemical domain, for prediction 

of activity of untested molecules. 

2) It acts as an informative tool by extracting significant patterns in descriptors related to the 
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measured biological activity leading to the understanding of mechanisms of giving biological 

activity. This could help in suggesting the design of novel molecules with improved activity 

profile. 

QSARs most general mathematical form is: Activity = f (physiochemical and/or structural 

properties) Data Requirement and Handling: Biological Activity for QSARs analysis, a dataset of a 

series of synthesized molecules tested for its desired biological activity is required. For a QSAR to 

be valid and reliable, the activity of all of the chemicals covered must be elicited by a common 

mechanism. The quality of the model is totally dependent on the quality of the experimental data 

used for building the model. Biological activity can be of two types: 

1) Continuous Response: MEC, IC50, ED50, % inhibition 

2) Categorical Response: Active/Inactive 

In order to have confidence in QSARs analysis, biological data of at least 20 molecules are 

recommended: 

1) Preferably tested in the same lab and by the same biological assay method. 

2) With wide range and uniform distribution of the activity data. 

3) Activity should well-defined in terms of either real number (continuous response, and cannot be 

e.g. >1000 or <1000) or in a particular class (categorical response). 

Molecular Descriptors: Molecular descriptors can be defined as a numerical representation of 

chemical information encoded within a molecular structure via mathematical procedure. Type of 

QSARs is based on the dimensionality of molecular descriptors used: 

0D:   

 These are descriptors derived from molecular formula, e.g. molecular weight, number and type of 

atoms etc. 

1D: 

A substructure list representation of a molecule can be considered as a one-dimensional (1D) 

molecular representation and consists of a list of molecular fragments (e.g. Functional groups, 

rings, bands, substituents etc. 

2D: 

A molecular graph contains topological or two dimensional (2D) information. It describes how the 

atoms are bonded in a molecule, both the type of bonding and the interaction of particular atoms 

(e.g. Total path count, molecular connectivity indices etc.  

3D: 

These are calculated starting from a geometrical or 3D representation of a molecule. These 
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descriptors include molecular surface, molecular volume and other geometrical properties. There 

are different types of 3D descriptors e.g. electronic, steric, shape etc. 

4D: 

 In addition to the 3D descriptors the 4th dimension is generally in terms of different 

conformations or any other experimental condition 
(4). 

Figure 5: 1D Representation 2D Representation 3D Representation4D Representation 
(5)

 

QSARs PARAMETERS: 

1. Lipophilic parameters: partition coefficient, Lipophilic -substitution constant 

2. Polarizability parameters: molar refractivity 

3. Electronic parameters: Hammett constant, dipole moment 

4. Steric parameters: Taft’s constant 

Applications of QSARs: 

In the field of drug design and medicinal chemistry the application of QSARs is given below. 

 To rationalization of new lead compound with enhanced biological activity. 

 To identify the toxic chemicals and toxicity of the drug molecule before the synthesis.  

 This will reduce the toxicity for environmental species and other biological system. 

 The optimization of pharmacological and pesticidal activity.  

 The identification and selection of the compound in order to get the best biological 

responds with better and optimal pharmacokinetics properties.  

 To identify the role of various properties to design the drug molecule and to know the best 

properties to improve the biological activity 
(5).
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MATERIALS AND METHOD 

1. Pubchem webserver 

2. Chemsketch 

3. Padel descriptor 

4. Protein data bank (PDB) 

5. Autodocktools 

6. E-dragon webserver 

Pubchem Webserver 

ATOM LABELS 

Annotate atoms/groups Choose the Text tool from Main toolbar, click on the position of the 

atoms/groups on the structure and start typing annotation Choose the Text tool again and click on 

the text on the structure. Format text color,  font,  size and style 1. Select text object with the 

selection tool from the Main toolbar 2. Go to Object>Object settings>Atom Labels and modify the 

settings >OK Show/Hide label on terminal Carbons and/or implicit Hydrogen Go to 

File>Document settings>Atom labels and check/uncheck Show labels on Terminal Carbons and/or 

Hide Implicit Hydrogens boxes at the bottom of the window >OK. 

Rings: 

To draw a cyclic compound, choose the Ring tool from the Main toolbar. Hold the mouse while 

dragging them to orient the ring. If you click on an atom or bond with a ring tool selected, the ring 

will be fused to the atom or bond. Delocalized rings to draw a delocalized ring choose a Ring tool; 

hold Command on the keyboard while clicking on the document window. Reducing ring size, for 

example, if you want to convert cyclohexane to cyclopentane, choose a bond tool, point at an atom 

while holding Shift and start dragging the atom onto the next one. The bond between the two 

atoms will disappear. 

MOVING/ROTATING OBJECTS: 

Moving an object Select the object with the Rectangle Selection tool from the Main toolbar, click 

and drag the object to a new location rotating an object select the object with the Rectangle 

Selection tool from the Main toolbar. The Rotation handles is at the top of the selected area. Rotate 

the structure while clicking on the Rotation handle. Rotating an object by a specific angle 

 1. Select the object with the Rectangle Selection tool from the Main toolbar.  

2. Go to Object>Rotate and enter the desired angle of rotation. Perspective Drawing 
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1. For example, to draw α-D-glucose 

1. Choose Cyclohexane tool from the Main toolbar. Choose the selection tool from the 

Main Toolbar to select the structure. Drag the structure to the right until it is about 200% 

stretched  

2. Add bonds and label atoms 

3. To enhance the front bond: choose the bold bond tool from the Main toolbar and click on 

the front bond 

4. To enhance the side bonds, choose the Wedge bond to from the Main toolbar and click on 

the two side bonds 
(6)

. 

 

Figure 6 : Pubchem webserver 
(6)

 

 

Figure 7: Pubchem Webserver 
(7) 



Hoque et. al.,  Am. J. PharmTech Res. 2018;8(3)  ISSN: 2249-3387 

www.ajptr.com  170 

 

Introduction to ChemSketch:  

ChemSketch is a free download for educational use. It can be used to produce structures of organic 

molecules, names of organic molecules as well as Lewis structures, 3D structures, space filling 

models or ball and stick models, among other things. 

Padel Descriptors: 

A software to calculate molecular descriptors and fingerprints. The software currently calculates 

1875 descriptors (1444 1D, 2D descriptors and 431 3D descriptors) and 12 types of fingerprints 

(total 16092 bits). The descriptors and fingerprints are calculated using The Chemistry 

Development Kit with additional descriptors and fingerprints such as atom type electrotopological 

state descriptors, Crippen's logP and MR, extended topochemical atom (ETA) descriptors, 

McGowan volume, molecular linear free energy relation descriptors, ring counts, count of 

chemical substructures identified by Laggner, and binary fingerprints and count of chemical 

substructures identified by Klekota and Roth
 (7)

. 

Autodocktools:                                       

1. Docking ➞ Macromolecule ➞ Set Rigid Filename 

2. Docking ➞ Ligand ➞ Choose… ind, ➞Select Ligand ➞Accept 

3. Docking ➞Search Parameters➞Genetic Algorithm 

4. Docking ➞ Docking Parameters… Close 

5. Docking ➞ Output ➞ Lamarckian GA… ind.dpf, ➞Save 

6. Docking ➞ Edit DPF… Cancel 

7. Run ➞ Run AutoDock 

8. Analyze➞ Dockings ➞ Open AutoDock vina result 

9. Analyze➞ Macromolecule ➞ Choose 

10. Analyze➞ Dockings ➞ Show Interaction 

11. Analyze➞ Conformations ➞Play, ranked by energy… 

12. Flexible Residues ➞ Input ➞ Choose Macromolecule… hsg1 ➞ Select Molecule ➞ Yes 

➞ OK 

13. Flexible Residues ➞ Output ➞ Save Flexible PDBQT… 

14. Grid ➞ Set Map Types ➞ Choose FlexRes…. Choose Flexible Residues from… ➞hsg1, 

➞ Select molecule providing flexible residues 
(8).

 

http://www.yapcwsoft.com/dd/padeldescriptor/Descriptors.xls
http://www.yapcwsoft.com/dd/padeldescriptor/Descriptors.xls
http://sourceforge.net/projects/cdk/
http://sourceforge.net/projects/cdk/
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E-dragon Webserver : 

Dragon is the world-wide most used application for the calculation of molecular descriptors. Its 

new version, Dragon 7.0, provides an improved user interface, new descriptors and additional 

features such as the calculation of fingerprints and the support for disconnected structures. 

Molecular descriptors: Dragon calculates 5,270 molecular descriptors, covering most of the 

various theoretical approaches. The list of descriptors includes the simplest atom types, functional 

groups and fragment counts, topological and geometrical descriptors, three-dimensional 

descriptors, but also several properties estimation (such as LogP) and drug-like and lead-like alerts 

(such as the Lipinski's alert). The wide range of different approaches and theories for descriptors 

calculation, and the correctness and precision of their implementation are ensured by the scientific 

supervision of the Milano Chemometrics and QSAR Research Group of prof. Roberto Todeschini, 

author with dr. Viviana Consonni of Molecular Descriptors for Chemoinformatics (the most 

complete reference for descriptors theory). 

User interface and batch calculation: Dragon provides an easy-to-use and intuitive graphical 

user interface (both on Windows and Linux platforms) and a command line interface, useful for 

the batch processing of large datasets. 

Fingerprints and molecular fragments: Dragon now provides also the calculation of hashed 

molecular fingerprints, fully customizable with several parameters, along with the generation of all 

molecular fragments used in the fingerprinting procedure. 

Analysis tools: the graphical user interface provides advanced tools to analyze the calculated 

descriptors (extended univariate statistics, pair-wise correlation, principal component analysis) and 

the possibility of importing user's defined variables (like available experimental values) and 

perform analysis on the merged set of calculated descriptors and user's variables. 

Disconnected structures: starting from version 7.0, Dragon allows the calculation of descriptors 

also on molecules with disconnected structure (e.g. salts, ionic liquids), providing different 

theoretical approaches to extend descriptors algorithms on such structures
 (9)

. 

RESULTS AND DISCUSSION: 

 Generation of Scaffold: 

 R3         Cl 

 Here, R3 position is substituted al of the halogen groups and also some other groups 

according to the concept of general chemistry. 

http://michem.disat.unimib.it/chm/
http://onlinelibrary.wiley.com/book/10.1002/9783527628766
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 After that we observed that Cl was more suitable to R3  substitution due their electro 

negativity   

 So that’s the reason we fixed the R3 position with Cl 

SCAFFOLD STRUCTURE WITH THEIR SUBSTITUTION:     

 

 

Figure 8 : Scaffold structure with their substitutions 

Table 1:  Calculation for generating of molecular descriptor 

Calculation for generating of molecular descriptors: 

Compound R1 R2 Log1/CMIC MR 

[cm
3
] 

MV 

[cm
3
] 

Η 

 

ST 

[dyne/cm] 

D 

[g/cm
3
] 

H1 H CH3 5.3700 68.96 205.6 1.568 41.6 28.33 

H2 CH3 H 4.991 50.38 201.9 1.500 40.4 27.09 

H3 OCH3 H 4.890 61.71 203.4 1.501 38.0 26.62 
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H4 Cl H 4.712 44.50 201.8 1.505 37.5 27.45 

H5 OH H 4.880 60.76 203.9 1.550 38.8 25.87 

H6 H OCH3 4.550 61.74 199.4 1.565 39.0 24.62 

H7 CH3 OCH3 5.100 64.16 202.8 1.562 39.2 26.98 

H8 OH OCH3 4.165 45.55 200.6 1.551 38.3 27.56 

H9 Cl OCH3 4.4894 44.59 201.9 1.560 41.6 22.76 

H10 OH OCH3 4.4449 43.59 203.4 1.560 39.8 24.73 

H11 H NO2 3.4497 65.88 198.1 1.530 36.3 27.87 

H12 CH3 NO2 2.4617 63.07 197.2 1.432 37.0 28.12 

H13 OCH3 NO2 4.4956 61.42 196.8 1.540 35.0 26.65 

H14 Cl NO2 4.4914 66.14 195.4 1.520 38.7 27.75 

H15 OH NO2 3.4648 59.43 200.3 1.520 39.8 26.49 

MR-Molar Refraction, MV- Molar Volume, η- Index of Refractivity,  ST- Surface   Tension, 

D- Density (Bold highlighted portion shows best result) 

QSARs ANALYSIS:        

Biological activity = 68.96(MR)+205.6(MV)+1.568(η)+41.6(ST)+28.33(D)  

MR-Molar Refraction, MV- Molar Volume,  η- Index of Refractivity,  ST-    Surface Tension, D- 

Density 

       R
2 

=  Approximately 0.99 

 

Figure 9 : Biological activity VS molecular descriptors 
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Table for molecular descriptors (standard drug):  

Table 2: molecular descriptors (standard drug) 

Log1/CMIC  MR(cm3)  MV(cm3)  η  ST(dyne/cm)  D(g/cm3)  

5.3900  70.95  206.7  1.678  42.4  29.33  

 

Figure 10 : 1Y9R Protein 
(9) 

Description about the protein: 

Crystal structure of the human mineralocorticoid receptor ligand-binding domain bound to 

deoxycorticosterone and harboring the S810L mutation responsible for a severe form of 

hypertension. 

Organism(s): Homo sapiens 

 Expression System: Escherichia coli 
(10) 

Table 3: Comparison between fit of standard & test molecules to 1Y9R (target) [Bold color 

shows that the particular series of compound had highest binding energy to selected target] 

SL NO Drug Binding energy to 1Y9R(Kcal/mol) 

1 Clonidine (standard) -6.694 

2 Test series-1 -7.992 

3 Test series-2 -7.005 

4 Test series-4 -7.117 

5 Test series-6 -7.112 

6 Test series-7 -7.553 

7 Test Series-8 -7.354 

8 Test Series-9 -7.253 

9 Test series-10 -7.038 

ADMET PREDICTIONS: 

 

 

 

https://www.rcsb.org/pdb/search/smartSubquery.do?smartSearchSubtype=TreeEntityQuery&t=1&n=9606
https://www.rcsb.org/pdb/search/smartSubquery.do?smartSearchSubtype=TreeEntityQuery&t=1&n=562
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Table 4: ADMET Predictions 

R1 R2 R3 Carcinogen 

  

Blood 

brain 

barrier  

Toxicity Hepato 

toxicity  

 

Mutagenecity  

 

Absorption  

 

H H CL Non-

Carcinogen 

Very Poor x x Non-

mutagenic 

Very Good 

CONCLUSION: 

 Hypertension is a burning problem in world wise.From the literature survey it has been observed 

that every year many people through all over the world affected with hypertension problem above 

30 years old. All the descriptors are (QSARs parameters) of Scaffold molecule H1 was 

satisfactorily explained (R
2 

= Approximately 0.99) with the graphical plot of Hansch Analysis. 

This compound had very poor blood brain barrier crossing label, good absorption, no 

hepatotoxicity, no mutagenecity. Beside this compound was non-carconogenic after in-silico 

prediction of ADMET.   
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